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GPR-SLICE Subscribers,      

We would like to welcome the following organizations to the GPR-SLICE 

community: &  

Dept of Geological Sciences and Engineering, University of Nevada, Reno 

1. Varkapitanysag Nonprofit ZRT, Budapest, Hungary 
2. Concrete N Core, Australia 
3. Geosystems Department, IDS North America 
4. Yenstron Corp, Taiwan 
5. Geomantis, Monterrey, N. L. Mexico 
6. Consultoria y Ingenieria Civil de CentroAmerica, San Jose, Costa Rica 
7. Lina T. Ramey & Associates, Houston, Tx 
8. Tauber-Herklotz-Consult GmbH, Germany 
9. Richard Grubb & Associates, Inc., Wake Forest, North Carolina 
10. University of Architecture, Civil Engineering and Geodesy, Bulgaria 
11. Cismondi srl, Cuneo, Italy 
12. Super High Frequency Equipment Company Ltd, Hanoi, Vietnam 
13. Terradar SA de CV, Mexico 
14. Vancouver Concrete Cutting, Canada 



15. Co.S.T.A.G. Soc. Coop., Italy 
16. French School of the Far East, Paris, France 
17. GAIA Emprise S.R.L., Italy 
18. Dr. Diego Ronchi, Italy 
19. Pops Tech, Itlay 
20. Meyer Land Surveying, California 
21. Blew and Associates, Arkansas 
22. Faculty of Letters, Art and Sciences, Waseda University, Japan 
23. Sriniva Sridhar, New York 
24. C3S Inc, Houston, Texas 
25. Alireza Shrimohamadi 
26. QCQA.com, USA 
27. TerraCarta, Netherlands 
28. Whiteknights Campus, University of Reading, United KingdomNetherlands 

 

     Multichannel licenses were included to Gaia Emprise S.R.L.- Italy, Tauber-Herklotz 
Constult GmbH-Germany, Concrete N Core-Australia, IDS North America and 
Varkaptianysag Nonprofit ZRT, Budapest - Hungary.  Byram Archaeological Consulting, 
LLC, California expanded their single channel license to multichannel.   Bridgedeck 
modules were delivered to GAIA Emprise S.R.L. Italy, Co.S.T.A.G. Soc. Coop., Italy and 
Cismondi S.R.L, Cuneo, Italy.  Yenstong Corp Taiwan took 3 licenses and 
Varkapitanysag in Hungary took 2 licenses. 

 

 

Major features and options added to GPR-SLICE include:     
 

• 2D/3D Horizon Velocity Model Migration 

• Overlays of X and Y planes in OpenGL 

• Compilation and display of horizons on vector radargrams 

• Reconfigured XYZ volume to XZY volume with auto vector radargram files 

generated 

• Conversion of 2D grid file format to 32 bit GPR-SLICE *.v7r radargram 

format – with example of ERT profiles shown in tunnel-vector display 

• Preservation of the bottom of profiles when using Truncate Horizon 1 

option 

 

 

 

 

 

 



2D/3D Horizon Velocity Model Migration 

 

     After many decades of only having either single velocity or 1d velocity models 

available in GPR-SLICE, the software has been enhanced to now handle 2d/3d 

velocity model migration.   In the first beta release, the velocity models 

developed in the Horizon menu are used to migrate the radargrams.   Initially to 

test the operation of the new feature, a simple GPRSIM simulation with a 5 block 

model earth is made (Figure 1).  In the Horizon menu, the velocity regions are 

manually inserted using the Draw button and clicking the location on the top 

surface of the model and saving these separate regions (Figure 2).  With the 

velocity model designed in the Horizon menu, the user must then set the velocity 

model in the Hyperbola Search menu to horizons (Figure 3).  After the horizon 

model velocity for each radargram is created one can then do a 2d velocity model 

migration (Fig 4).   A real-world example with rebar located near the bottom of 

a slab is shown with its horizon model and then is 2d velocity model migrated 

(Figure 5).   With multiple horizon models on each separate radargram, the 

velocity migration is in essence a 3d horizon velocity model migration! 

 

     Currently this advanced migration feature allows up to 15 different velocities 

to be used in the horizon models.  Should a need for more velocity layers be 

required we will see about placing velocity model legends available for each 

individual radargram.   When users start to request velocities values such as in 

gradient zones then we will need to progress beyond the horizon menu and have 

solid 3D volume models in the distant future to support those trying to get better 

results. 

 



 

Figure 1.  Example of GPRSIM simulation of a utility buried in 5 different 

materials. 

 

Figure 2. Example of creating a 5 block horizon model. 



 

Figure 3.   Location in the Hyperbola Search menu where the velocity model is 

set to “horizon”. 

 

 

Figure 4.  Example of 2d horizon block model migration (bottom diagram) along 

with comparison of a single velocity migration. 



 

Figure 5.  Example of 2d variable horizon velocity model migration. 

 

 

 

 

 



Overlays of X and Y planes in OpenGL 

 

     Dr. Guido Tronca with www.GTstudioservice.it in Italy is working on 

infrastructure surveys in vector space.  He often has vertical rebars and other 

vertical structures in which he wants to compile the full complement of reflections 

in the X or Y planes in the data volume.   Just as with overlays of the relative-

strongest-reflectors on the flat Z planes has been available since the inception of 

OpenGL, overlays both in X or Y planes was not available and was just 

implemented in GPR-SLICE.   Shown in Figure 6 is an example of some 

progressive overlays for a structure that Guido had recently surveyed. 

 

The operation for overlays is implemented by:   

1) choosing either X, Y or Z planes    

2) scrolling to the scan location one wants to start overlaying reflections 

3) click the "O" button 

4) click the step +/- button or use the slider bar to start adding reflections. 

 

 

Figure 6.  Overlay of the relative-strongest-reflectors along the X plane in a 3D 

Volume 



Compilation and display of horizons on vector radargrams 

 

    It seems the demands for more vector options by users is driving the 

development here.   One application that is being studied is railroad tunnel linings 

and the thickness of these.    Gianluca Catanzariti with 3DGeoimaging.com is 

examining railroads in vector space and needs to provide the client with 3D 

imagery of the thickness of tunnel linings.    

     In GPR-SLICE one will first use the Horizon menu and detect the desired 

layers.   The vector-horizonN.dat are then compiled.  The compilation here is a 4 

column *.dat file with profile name, x, y, z (Figure 7).   There is also a vector-

horizon-thickN.dat, vector-horizon-ampN.dat files created in addition to an 

export file to be used in 3rd party software if necessary.  For vector data, unlike 

regular surveys, horizon1 should be compiled as this will show the vector position 

of the top of the profiles.  On the Horizon listbox these vector horizons can be 

shown individually (Figure 8, 9) or altogether (Figure 10). 

     The displayed horizons are currently just the vector horizon profiles.  In the 

future we hope to develop solid 3D vector meshes from the vector horizons for 

improved displays and export.   

 

 

Figure 7.  Compilation of vector horizons in the Static menu. 



 

Figure 8.   Example display of horizon 1 – the start of vector profiles – in this 

case the outline of a tunnel is visualized. 

 

 

Figure 9.  Example of displays of horizon 2- the subsurface tunnel lining. 



 

Figure 10.  Example of 3 vector horizons 1,2 and 3 for a longitudinal tunnel 

project. 

 

 

 

Reconfigured XYZ volume to XZY volume with auto vector radargram 

files generated 

 

     Many concrete surveyors often are doing rebar and other surveys on vertical 

walls.  A convenient button to auto rotate a volume processed as though it were 

flat on the ground to a vertical survey grid has been available in the 3D Volume 

pulldown menu and called Reconfigure XYZ to XZY (Figure 11, 12).   This menu 

will now also conveniently create all the vector radargram navigation files along 

with a new info-xyz.dat vector info file.   With the reconfigured volume one will 

now be able to export drawn objects into their true positions allowing integration 

of these survey grids directly into cad drawings (Figure 13).   

 



      (A more general menu is also available which is the vector volume rotation 

menu which can also be used to generate rotated vector volumes of up to 4 

volumes simultaneous - for instance on a square column.  This menu does not 

yet auto create vector files for the radargrams.) 

 

Figure 11.  Menu location on the 3D volume pulldown to reconfigure a horizontal 

volume to a vertical volume along with creation of vector profile information. 

 

 

Figure 12.  Example of reconfiguring a horizontal volume to a vertical volume. 



 

Figure 13.  Example of drawing pipes/rebar on a vertically reconfigured volume. 

 

 

 

Conversion of 2D grid file format to 32 bit GPR-SLICE *.v7r radargram 

format - with example of ERT profiles shown in tunnel-vector display 

 

     Recently, Dr. Sanjay Rana with Parsons Overseas in India, asked if it was 

possible to show ERT profiles in vector space.  Sanjay had recorded ERT inside a 

tunnel along the longitudinal axis and he wanted to place these profiles into their 

true vector space.   One method to do this was to take advantage of vector 

radargram display functionality in GPR-SLICE.   For his ERT data that was 

imported and gridded via the Import 2D Geophysical Data menu (Figure 14), a 

new function to export 2D grid data to radargram format was added to the Grid 

menu (Figure 15).   On export a new information file infov-v7r.dat is generated 



with initial XY survey information.  The user can then adjust the information file 

to a Y survey file for vector displays (Fig 16), and click the Ang X, Y, XY to 

GPS/Vector button to convert the information file to vector.  Then in the Vector 

Longitudinal Tunnel menu, they can generate the vector files for these ERT data 

(Figure 17).   All these steps are "conveniently" listed in the Vector Longitudinal 

Tunnel menu as well.   One issue is the original data values for ERT are converted 

to the full binary integer resolution at 32 bits and the legend correctly shown in 

the 2D grid files is not available in OpenGL displays. 

 

 

 

 

Figure 14.  First step for making vector ERT is to import and grid the profiles. 



 

 

Figure 15.  The next step is to convert the ERT grid maps into .v7r profile format. 



 

 

Figure 16.  The ERT info file is then converted to vector format. 



 

 

Figure 17.   The final step to make ERT vector profiles is to use the Vector 

Longitudinal menu and set the angle and radius of the tunnel and then generate 

the vector files – followed by OpenGL. 

 

 

 

Preservation of the bottom of profiles when using Truncate Horizon 1 

option 

 

     The Truncate Horizon 1 will remove a variable horizon profile detected on 

each radargram in a project.   Typically, this option would remove data at the 

bottom of the radargrams to make all the profiles in the project the same sample 

depth.   A request came to have the option to preserve the bottoms of the 

radargram and to included null data where needed.   With maximum setting on 

the samples/scan in the Radar Edit menu, the bottoms of radargrams that are 



truncated to the variable horizon #1 made in the Horizon menu, the total scan is 

preserved at depth and null - 0 data are added onto the edited profiles (Figure 

18).    

 

Note: time slices near the bottoms of the radargrams will be irrelevant once 

slicing past the horizon of shallowest profile starts.  The default setting is 

minimum checkbox highlighted which will truncate the bottom of all profiles to 

make them the same depth. 

 

 

 

Figure 18.  New option to Truncate horizon 1 but to preserve the bottoms of the 

radargrams by including null data. 

 



 

Additional options added to GPR-SLICE Software  

  

7/20/21 US Radar version 5 GPS/TS log file format added 

7/15/21 Improvement of GPS filter on endpoints 

7/13/21 Scan 0 forced to scan 1 in import of customizable navigation files on the XYZ to NAV 
button in the Edit Info File menu 

7/11/21 Save All and Save From buttons renamed in the Pixel Transform menu to Copy to All and 
Copy From to avoid confusion in resetting all transforms to the active transform 

7/4/21 Impulse Radar Crossover and PinpointR total station format added 

6/23/21 Comprehensive export file for hyperbola detection written to the \dat\ folder 

6/11/21 US Radar total station format added to Edit Info File menu 

6/9/21 Reporting of profile at which UTM zone changes (or bad GPS) are detected  

5/31/21 Longitudinal tunnel surveys made on the inside or outside option added to Vector menu 

5/18/21 Proceq Nav button renamed Proceq Nav Line to distinguish from Proceq Nav Area button 

5/17/21 Vector columns in navigation files can be multiplied in the GPS track menu - e.g. to give 
the reverse projection 

5/10/21 Addition of separation of GSSI SIR 30 in 8 channel mode 

5/4/21 Proceq multiple GPS grid collection added to a single inclusive grid operation in the Edit 
Info File menu 

4/28/21 Truncate samples in the Radar Edit menu opened to truncate from a start sample other 
than sample 3 

4/27/21 Radarteam Get XY button added to the Edit Info File menu 

4/17/21 Test migration just shows migrated radargram and not redrawing of the unmigrated 
radargram 

4/15/21 Vector track displays in OpenGL added to the Grid2D pulldown listbox 

4/15/21 Older menu for just OpenGL tunnel vector radar displays placed back into the menu 

4/15/21 Vector orthographic checkbox added to show pipes in their true (elliptical) dimension in 
OpenGL Volume Draw menu with 2 times vertical scale - in addition, initial graphic displays will be 
orthographic in xyz dimensions for vector displays 

4/12/21 OpenGL Texture rendering checkbox removed from Options menu as all imaging is now 
texture method other than topo warping or GPS radargram displays 

4/10/21 OpenGL XYZ-2D launch of the R-2D menu no longer has limitation on display of GPS 
radargrams and can handle equidistant displays or constant scan or full displays...etc. 



4/9/21 Extended radargram names accommodated with extended menu slot sizes 

4/7/21 Proceq SEGY GET XY button programmed for _HF and _LF channels 

4/6/21 Resample in Range in the GPS track menu adjusted to just write out the actual scan and 
not interpolated at the closest scan just equal to or greater than the resample range 

4/5/21 Importgeodata menu adjusted to explicitly set the output filenames to the export identifier 
without R- appended for batch operations 

4/5/21 Update button added to Volume Tunnel Warp to update the effective tunnel radius by 
setting the number of equivalent Z cells; for the warping case of angles from exactly 90-270 only 
the half volume that is warped is written for space economy 

4/5/21 Software adjustments to show null areas on ERT data in vector space 

4/5/21 Conversion of imported 2d data/gridded and then exported to 32 bit radargram format *.v7r 
placed in the Grid menu for export 

3/30/21 Migrator table dimension reduced to double dimension for performing 1D 
velocity profile migrations 

3/26/21 Core file displays in the Horizon menu reset back to closest point of approach for GPS 
radargrams; xy profiles left as set distance 

3/24/21 Prism-segy export format added to the Filter menu 

3/23/21 Vector volumes distinguished from depth rad volumes in OpenGL labeling 

3/19/21 Mala Mira HDR - multiplex format added to equipment list 

3/18/21 Batch Depth Radargram button added to the Horizon Detection menu for converting time 
radargrams to depth radargrams; also depth radargrams are renamed with the append character 
"d-" in the \topo folder and a info-depth.dat file is automatically made - allowing for regenerating 
unique horizons which are adjusted to depth and can be visualized in OpenGL 

3/16/21 Raptor multichannel info file creation for non-GPS surveys and zig-zag data has option to 
keep start fixed and add on the survey wheel length 

3/13/21 Horizon overlay in Bridgedeck module with horizon flag set in Options menu 

3/12/21 Batch jpg button added to Bridgedeck module 

3/11/21 Gridblock numbering changed to consecutives numbers 

3/11/21 Gridblock lines added as Grid2D option in OpenGL for appending onto the current 
drawing 

3/10/21 Renumber button added to Bridgedeck module for the user to manually set when they 
want inserted detections to be renumbered 

3/10/21 Font sizes default removed from automatic marker labeling checkbox allowing this to be 
customized 

3/9/21 Grid file header adjustments made to accommodate non-GPR import data 



3/3/21 Options to scale x and y columns on import for non-GPR geophysical data 

2/26/21 Fix for Proceq GPS log files with incorrect NMEA strings written in the list 

2/13/21 Three extra decimals added to velocity resolution in the Options menu to account for 
Pundit sonogram data + time window auto read added 

2/9/21 Batch dxf in the Pixel Map menu opened up  

2/9/21 Mira to Nav button for Mala Mira HDR equipment opened in the Edit Info File menu to be 
able to use *.pos files 

2/9/21 Add character menu item included in the XYZ to NAV generalized navigation import in the 
Edit Info File menu to account for GPS log files not matching the channel 1 naming conventions 

2/9/21 Pundit 8000 App v4.3.1 B read added to Create New Info listbox 

2/6/21 Improved interpolation on direct 3D volume compilation for multichannel datasets 

2/5/21 Pundit 8000 App v4.3.1 read added to the Create New Info 
listbox                                           

 
*This newsletter is available in *.pdf form at https://gpr-survey.com/newsletters.html   


